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To find online versions of these 
tutorials including video, please visit 
bareconductive.com/make

Share your project  
@bareconductive

 

Touch Board 
One tool, a million possibilities. Create 
sensors with its 12 electrodes to trigger 
sounds through its MP3 player. Use our 
cross-platform installer to add loads of 
code examples to the Arduino IDE. 

Key Features
_ Capacitive touch and distance sensing
_ Arduino compatible
_ No programming required
_  Code and libraries for the Arduino IDE  

for optional programming
_ MP3 Player / MIDI device
_ MicroSD card socket
_ Standard 3.5mm audio socket
_ LiPo battery charger
_ USB HID compatible
_  USB MIDI compatible  

Electric Paint 
Your design and electronics projects are 
about to change forever. Paint circuits and 
sensors or use as a conductive adhesive on 
almost anything including paper, plastic, 
textiles and conventional electronics. 

Key Features
_ Conducts electricity when dry
_ Paint, stencil or screen print
_ Air-drying
_ Nontoxic and solvent free
_ Water soluble
_ Paint over with water-based paints 
_ Electric Paint 10ml dispenses up to 5m 
_ Electric Paint 50ml screen prints up to 0.8m2 

Components glossary 
A guide to what you get  
and what it’s for:

About 
Definitions and resources for 
Electric Paint, Touch Board  
and Printed Sensors.

Printed Sensors - MIDI  
Paper Orchestra Creating paper 
instruments  to compose a tune.

Electric Paint - Memory Game 
Painting an interface to play an 
interactive memory game.

Capacitive Sensing - Interactive 
Posters  Plan, design, make and  
program interactive posters.

Let’s get started
This guidebook has all the 
instructions you need to 
make three projects using 
the Touch Board, Electric 
Paint and Printed Sensors.
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MicroSD card 
The microSD card is used to store MP3 
sound files for the Touch Board’s mini MP3 
player. It’s just like the memory card  
in your camera.

MicroSD Card Reader 
The microSD card reader allows you  
to view and change the MP3 files on  
the microSD card via your computer.

Mini Speaker 
This speaker is light, portable, and USB 
chargeable. The Touch Board has an on 
board audio socket so you can plug in the 
speaker, or connect your own speakers or 
headphones if preferred.

USB Hub 
Use the USB hub to power your Touch 
Board. Each hub has 4 USB sockets so you 
can connect up to 4 devices at once. 

Instrument Sensors  
These sensors have been pre-printed in 
the shape of an instrument with Electric 
Paint, and coated with a clear seal making 
them smudge and water resistant. This 
means you can start playing music 
immediately. Every sensor has exposed 
(unsealed) nodes, which can be connected 
to the Touch Board.

Printed Sensors  
Test your ideas quickly without needing 
to design your own pattern or waiting for 
Electric Paint to dry. Customise and hack 
your sensors to make them fit any project. 
Every Printed Sensor has 16 exposed 
(unsealed) nodes.

Carbon Dots  
Use these adhesive carbon dots to quickly 
and reliably connect your Touch Board 
to your sensors. They’re conductive and 
double sided, which means you can easily 
attach and remove your Touch Board.

Micro USB cable 
The Micro USB cable allows you to power 
your Touch Board directly from your USB 
hub. When connected to your computer, 
you can use it to send data to and from 
the Touch Board, and to upload code via 
the Arduino IDE.

Alligator clip test leads 
Alligator clips provide an easy way to 
connect to your Touch Board’s electrodes 
or prototype different layouts. Use them 
for projects where you want to quickly 
test your sensors before making a 
permanent connection with Electric Paint.

Sticky Tabs 
Use these tabs to mount your Touch 
Board or sensor cutouts to a wall and 
make sure they stay in place.

Velcro Stickers 
Mount your speaker easily to the wall and 
detach for charging. Use these if you are 
building a vertical project, or if you want 
to secure the speaker in place. 

 

 

ADVANTAGES / PRODUCT BENEFITS

• Electrically conductive

• Nontoxic

• Water-soluble

• Compatible with standard printing processes 
 
 

COLD SOLDERING 

Electric Paint can work well as a cold solder 
joint. Whether used to solder a surface-mount 
or through-hole component onto a circuit 
board, or to adhere a component to a piece 
of paper. This material is almost infinitely 
repairable. These unique properties mean that 
components can be harvested from projects, 
cleaned and reused. 
 
DRYING 

Electric Paint dries at room temperature, and 
gives off no fumes during the drying process. 
Drying time can be reduced by placing the 
material near a low intensity heat source. 

CONDUCTIVITY

Electric Paint contains conductive carbon 
particles which come into contact when 
water evaporates from the material, making it 
conductive when dry. When powered, Electric 
Paint can hold an electric charge to create a 
capacitive sensor, or allow an electric current 
to flow.

POWER SOURCES

Electric Paint is designed for use with low 
voltage DC power sources at low currents and 
has not been tested with sources exceeding 
12VDC at 50mA. Higher voltages are not 
recommended.

PROPERTIES

Color / Black

Viscosity / Highly viscous

Vehicle / Water-based

Shelf Life / 6 months after opening

Drying / Dries at room temperature in 5 – 15min 

APPLICATION

Electric Paint is a unique material that can be 
applied in many different ways, from a paintbrush 
and stencil to common printing processes like 
screen-printing. To achieve consistent electrical 
performance, it is best to apply Electric Paint in 
an even layer. It is not inkjet printer compatible. 
Electric Paint can be removed with water. 

SUBSTRATES

Electric Paint acts much like a poster paint, and 
can be applied to a wide range of materials. It 
adheres well to paper, wood, acrylic and textiles. 
Hydrophobic surfaces such as some glass and 
plastics will exhibit poor adhesion, though this 
can be improved by roughing the surface with 
sandpaper or similar.

FLEXIBILITY

Electric Paint is somewhat flexible, but this 
depends on two factors; layer thickness and 
choice of substrate. Regardless of substrate, 
a consistently thin layer of paint creates the 
most flexible surfaces. Areas of paint with wide 
variation in thickness tend to fracture. Substrates 
which are flexible, but not stretchy (such as paper) 
work better than materials like synthetic fibres 
which stretch in multiple dimensions.

Electric Paint
Conductive paints combine 
resins or adhesives with powdered 
conductive particles to create a 
conductive liquid or paste. When 
dry, the conductive particles 
in the paint allow electricity to 
flow through the material. They 
are used for printing conductive 
traces in circuit boards, or in 
our case, for making painted or 
printed sensors. 

Electric Paint is a nontoxic, water based, 
conductive paint. It uses carbon black as a 
conductor so it’s not metal based. Electric 
Paint adheres to a wide variety of substrates 
and is easily removed with water. It is black 
in color and can be sealed and painted over 
with a water-based paint. 



How to screen print 
with Electric Paint
Screen print with Electric Paint to create 
crisp graphics and sensors. This is a simple 
method you can use to apply an even and 
thin layer of Electric Paint onto a flat surface. 
With this method you create multiple 
copies of the same image or highly precise 
graphics. This tutorial shows how to use a 
vinyl stencil with your screen.

Search: screen print 

Resources 
www.bareconductive.com/tutorials

A quick tutorial on 
diluting Electric Paint
Electric Paint is composed of conductive 
particles suspended in a water-based 
solution. As such, it can be diluted by 
simply adding water. Be careful though! This 
will also decrease the conductivity of the 
material. Follow this tutorial to find out how 
you can dilute Electric Paint for best results.

Search: dilute

How to seal  
Electric Paint
Electric Paint is a water-based paint, which 
means that it is easy to wash off, but also 
can be prone to smudging – even when it’s 
dry. By sealing the paint, you will protect 
your design and make it smudge-proof. This 
tutorial shows you how to use a clear coating 
to seal Electric Paint. 

Search: seal

Create a tape stencil 
for Electric Paint
Using Electric Paint to create slick graphics is 
easy, even if you don’t have screen printing 
equipment. This tutorial provides some tips 
on how to use a stencil with Electric Paint. 
You’ll get a quick demonstration on how you 
can use a stencil or create your own using 
masking tape.

Search: stencil

How to cold solder 
Cold soldering is a great alternative to 
traditional soldering and doesn’t require a 
solder iron. All you need is Electric Paint! In 
this tutorial, we’ll demonstrate how to  
cold solder onto the Touch Board and  
other materials!

Search: cold solder 

Check out these online resources for step-by-step instructions, tips 
and techniques on how to use Electric Paint. 

Tutorials
Check out these online 
resources for step-by-
step instructions, tips and 
techniques on how to use 
Electric Paint.
www.bareconductive.com/tutorials

 

 

PRODUCT FEATURES

• Capacitive touch and distance sensing

• Arduino compatible

• Code examples and libraries for the  
    Arduino IDE

• Pin layout supporting Arduino shields

• HID and MIDI capable 

interface, or to provide information remotely 
about a specific event. 
  
TARGETS 

The Touch Board’s electrodes can detect a 
range of targets all the way from the touch of 
a fingertip, to a drop of water, or the proximity 
of a whole person. This target detection can be 
optimised through a combination of electrode 
calibration and sensor design. 

ELECTRIC PAINT

Electric Paint can be used alongside the Touch 
Board to extend its electrodes and create 
sensors beyond the hardware. The paint can be 
applied to most materials  free-hand using the 
Electric Paint tube, or with a paintbrush. Electric 
Paint can also be printed to create thin, flexible, 
low-cost sensors. This material and hardware 
combination is a powerful toolset to integrate 
capacitive sensors into the environment.

PROGRAMMING

The Touch Board can be programmed using 
the Arduino IDE just like any Arduino board. 
We use the Arduino platform because it is 
easy to understand for people who have 
not programmed before, while still allowing 
advanced users to write sophisticated programs. 
We have a library full of code examples so that 
getting started with more complex projects is 
easy even for those with very little programming 
background.  

 

PROPERTIES

12 touch electrodes / Connect to the MPR121 
for capacitive touch / proximity sensing

Audio output / 3.5mm stereo socket

Storage / Up to 32GB via microSD card

Power / via Micro USB

Reset / button to recalibrate sensors 

APPLICATIONS

The Touch Board can be used to control 
or automate outputs triggered by touch or 
proximity. Common outputs are lights or sounds 
to create interactive interfaces. However, the raw 
data can also be used for passive monitoring or 
occupancy sensing. 

FIELD PROJECTION

Each of the Touch Board’s 12 electrodes can 
create its own electromagnetic field which can 
be calibrated to detect up to 1m in distance. 
This means that sensors can be made to work 
through other materials, and even on three-
dimensional shapes. This allows for a unique 
degree of design freedom as sensors can be 
hidden, and turn materials and objects into 
‘smart’ materials and objects.

INPUTS 

The Touch Board’s electrodes can be used to 
trigger events such as sound or light based on 
active inputs such as gesture or touch. Passive 
events like contact or proximity can also be 
mapped and the data interpreted to trigger an 

Touch Board
Capacitive sensing is a proximity 
sensing technology. Capacitive 
sensors work by generating an 
electric field and detecting nearby 
objects by sensing whether this 
field has been disrupted. These 
sensors can detect anything 
that is conductive or that has a 
significantly different permittivity 
than air, like an animal, human 
body or hand.

The Touch Board is a microcontroller with 
12 dedicated capacitive touch sensing 
electrodes. It can be programmed using the 
Arduino IDE, and can be recognised by a 
computer as a USB HID device, a keyboard, 
MIDI device, serial and more.



What is distance 
sensing?
Although it’s called the Touch Board, what 
the electrodes are really doing is sensing 
proximity via capacitive sensing. When you 
set a sensor’s thresholds to be relatively 
high, the Touch Board only responds to 
actual contact or touch, rejecting  
proximity events.

Search: distance 

Resources 
www.bareconductive.com/tutorials

Making distance 
sensors: trigger the 
Touch Board with 
proximity
The Touch Board works great out of the 
box to detect touch. But it’s also possible to 
trigger sounds from a distance. We call this 
proximity mode. This tutorial will take you 
through an example and explain  
these principles.

Search: distance sensors

What is capacitive 
sensing?
The 12 sensors of the Touch Board use 
capacitive sensing. But what exactly 
is capacitive sensing? And what other 
technology uses capacitive sensing? This 
tutorial gives you a brief oversight about this 
amazing technology. 

Search: capacitive

Touch Board + 
Grapher
We’ve developed the Grapher as a tool to 
visualise the 12 sensors of the Touch Board. 
This way you can see how your sensors are 
behaving, which is useful for developing  
and prototyping.

Search: grapher

Getting started with 
the Touch Board 
This tutorial is a step-by-step introduction to 
your Touch Board. It will take you through 
powering it up and changing the sounds on 
your micro SD card, all the way to using our 
stencil and Electric Paint to create a series of 
graphical touch sensors on paper!

Search: getting started  

Check out these online resources for step-by-step instructions, tips 
and techniques on how to use the Touch Board. 

Tutorials
Check out these online 
resources for step-by-
step instructions, tips and 
techniques on how to use 
Electric Paint.
www.bareconductive.com/tutorials

 

 

PRODUCT FEATURES

• Water and smudge resistant 

• Customisable into custom shapes and sizes

• Flexible - sensors to be bent without cracking

• Recyclable 
 
 

cut them down to at least 16 pieces, with an 
access node each. You can also cut strips of the 
sensors and use them to connect the front of 
your surface to the back, by bending the sensor 
around a corner. The pattern on the Printed 
Sensors was designed to be used as a touch or 
proximity sensor. 

INSTRUMENT SENSORS

Instrument Sensors are a specific design of our 
printed sensor technology. This pack contains 
three different instruments: piano, drums, and 
sampler. You can use them to either play the 
respective instrument on the Touch Board or 
you can change the board’s code and use the 
sensors as interfaces for your programme. 

SENSOR DESIGN

Printed Sensors and Instrument Sensors 
are examples of the types of designs you can 
achieve when designing printed and flexible 
sensors. Depending on the application, you 
can create your own sensors on a range of 
materials. When using proximity sensing, the 
pattern on the sensors can affect performance, 
so it’s important to follow our sensor design 
guidelines. You can use a range of conductive 
inks or experiment with our Electric Paint to 
create sensors with various printing methods. 

PROPERTIES

Dimensions / 210mm x 149mm

Card Stock / 270gsm

Hatch Fill / 45% filled with Electric Paint

Nodes / exposed nodes

APPLICATIONS

Printed Sensors can be used with the Touch 
Board to quickly extend the sensors from the 
board. They can be used as touch or proximity 
sensors. Printed Sensors can be attached to any 
surface like wood, cardboard or foam to create 
smart interfaces. Use tape, glue, spray mount or 
any other standard adhesive to attach them.

CONNECTING

Printed Sensors are sealed, however each 
sensor has up to16 unsealed access nodes. 
These allow you to connect the sensors to the 
Touch Board. There’s many different ways to 
connect to your Printed Sensors. Electric Paint 
can be used as a cold solder, or carbon dots 
can be used to connect between hardware and 
sensor, although this is a more expensive option. 
For temporary and quick prototyping, alligator 
clips can be used to connect from the sensors’ 
nodes to the electrodes. Connections must be 
made via the exposed nodes.

USAGE 

Printed Sensors are screen printed on paper, 
which makes them flexible, and allows you to 

Printed Sensors
Flexible sensors can be made 
using techniques such as screen 
printing, flexography, gravure, 
offset lithography, and inkjet. 
They are manufactured on 
a range of substrates, from 
plastics, to paper and textiles. 
The Printed  Sensors in this pack 
are inexpensive because they 
are printed on paper, using our 
Electric Paint. 

Your Printed Sensors and Instrument 
Sensors have been screen printed with 
Electric Paint and coated with a clear seal, 
making them smudge and water resistant. 



The best design 
for printed flexible 
sensors
When you look at the Printed Sensors, the 
first thing you might notice is the gridded 
pattern of Electric Paint. More than just a 
good looking pattern, the Printed Sensors 
show how precisely you can work with our 
paint. 

Search: sensor design 

Resources 
www.bareconductive.com/tutorials

How to use stencils 
with Printed Sensors
There are many benefits to using stencils 
in your projects. They’re a great way to 
create precise forms and lines with Electric 
Paint, even if you don’t have a steady hand. 
Additionally, you can cover the electric 
wiring that makes your project work. Its a 
cleaner, more finished way to present your 
projects and its also quite simple

Search: stencils

Electric Paint sensor 
design rules of thumb
In this tutorial we will give you some 
guidelines for creating painted sensors. 
Following these guidelines you should be 
able to design the best sensors for your 
specific application.

Search: sensor design

How to integrate 
Printed Sensors
Using Printed Sensors is a great way to save 
time, as they can be cut into any shape you 
like, are already sealed for you and don’t 
require drying time. Your interface can be 
a variety of things, such as paper, wood or 
plastic – whatever works for your project. 

Search: integrate 

How to cover Printed 
Sensors with a 
different colour 
If you need to quickly create a touch or 
proximity sensor in a colour other than black, 
then this is the right tutorial for you! In this 
tutorial we are going to show you how to 
cover Printed Sensors with a different colour. 

Search: cover printed sensors 

Check out these online resources for step-by-step instructions, tips 
and techniques on how to create your own Printed Sensors. 

Tutorials
Check out these online 
resources for step-by-
step instructions, tips and 
techniques on how to use 
Electric Paint.
www.bareconductive.com/tutorials

Touch Board, Electric Paint 10ml tube, 
Instrument Sensors, carbon dots, mini 
speaker, micro USB cable
—
Also useful but not included: masking 
tape, wall-mounted USB plug

TAKE IT FURTHER 
1 //  Explore the MIDI sound library 
and select different sounds for your 
sensors. 
2 // Design your own Instrument 
Sensors using Electric Paint
3 //  Use the Instrument Sensors as 
interfaces for a game

MIDI Paper 
Orchestra
Make a paper piano, drum, or 
sampler using the Touch Board 
and Instrument Sensors. 

When you’re done, get your 
teams to band together and 
play their favourite tune, or 
create custom intstruments.



node of the Instrument Sensor. Press down 
firmly through the plastic. Repeat the process 
with all the nodes. Then attach the Touch Board, 
carefully aligning the electrodes of the Touch 
Board with the carbon stickers. 
If you want to cold solder the Touch Board, 
please have a look out our cold soldering 
tutorial: http://bit.ly/TBWPSolder

Step 4 Upload the MIDI code   
With the board attached to the nodes, it’s time 
to upload the MIDI code to the Touch Board. 
Connect your Touch Board to your computer 
with the USB cable and turn the device on. In the 
Arduino IDE, go to

File→Sketchbook→Touch Board 
Examples→Midi_Piano

Make sure to select the correct Board and Port 
settings before hitting upload.

Step 5 Plug and Play   
When you have uploaded the code, take the 
speaker, turn it on and connect it to the Touch 
Board. Try playing the notes on the paper, you 
should hear a sound when you touch a key. 

Step 6 Swap instruments  
The MIDI code is set to “electric piano” by 
default. If you want to try out a “grand piano”, 
a different instrument or sound, you can find 
detailed instructions on how to change the 
instruments inside the Midi_Piano code. Use 
the other Instrument Sensors to play different 
instruments or form an orchestra! 

We’d love to see a video of your paper 
orchestra! Share your images or videos 
via Instagram or Twitter @Bareconductive.

If you have any trouble, have a look online at our 
Troubleshooting Guide, our FAQs or contact us 
at info@bareconductive.com 

Step 1 Set up your digital tools 
If you haven’t set up the Touch Board with 
Arduino before, please do so by following this 
online tutorial: http://bit.ly/TBWPArduino

Step 2 Solder the MIDI solder bridges 
To use the Touch Board’s onboard MIDI 
functionality, you need to connect two solder 
bridges on the board. You can cold solder the 
bridges using Electric Paint. If you want to go 
back to MP3 playback mode and play MP3 
sound at a later stage, simply remove the solder 
bridges.

Give the paint a few minutes to dry.

Step 3 Connect to your Instrument Sensor 
Your Instrument Sensors have been screen-
printed with Electric Paint, so attaching them to 
the Touch Board will turn them into an interface.

To attach the Touch Board to the Instrument 
Sensor you can either use carbon dots or cold 
solder with Electric Paint. Carbon dots aren’t as 
stable as Electric Paint but they don’t require any 
drying time. Electric Paint takes a few minutes to 
dry, but is more stable.

If you are using the carbon dots, peel the white 
back off the first carbon dot. With the back 
removed, center the carbon dot to the round 

Step 2 Cut the buttons 
To begin, you’ll need 3 yellow, 3 green and 2 
red sheets of paper or cardboard. Cut these 
into shapes about 30cm in size. Cut out a small 
triangle for your start/reset button. Mount these 
onto foam board to make sure your buttons are 
robust. 

Step 3 Paint the buttons  
Next, we’ll apply Electric Paint to turn the 
buttons into sensors. We painted diagonal lines 
and used masking tape to neatly apply the 
paint. Make sure to ‘fluff’ the tape first to avoid 
ripping the cardboard.

Paint a line on each of the 8 buttons and 
cover the start button completely. Remove 
the masking tape, and let the paint dry for 
15 minutes. You should have 8 buttons with a 
diagonal line, and a black start button.

Touch Board, Electric Paint 50ml jar,  
Micro USB cable, alligator clip test leads
—
Not included: masking tape, paint brush, 
coloured paper, foam board

TAKE IT FURTHER
1 // Set a new brief, get each team to 
open up Processing and modify the code 
to change the visual interface, or have 
them change the game completely.
2 // Get each group to create a new 
game from scratch. They can design an 
interface using Electric Paint and modifiy 
the Touch Board’s inputs/outputs using 
the Arduino IDE.

Memory Game
Use Electric Paint to design 
and control an interface.
Configure the Touch Board 
as an HID keyboard.

When you’re done building 
this project you can get 
competitive with this 
interactive memory game.

Step 4 Upload the code 
While the paint dries, connect your Touch Board 
to a computer and turn it on. In the Arduino 
IDE, go to

File→Sketchbook→Touch Board 
Examples→HID_Keyboard 

Go to line 50, comment it out, and comment 
line 52 in. Make sure to select the correct Board 
and Port settings before hitting upload.

When the code has been uploaded, swipe 
across the electrodes on the Touch Board, 
from E0 to E8, to test the code. The numbers 
“801234567” should appear. You can remove 
the line, we’re just checking the code is working 
as expected.

Step 5 Prepare the game in Processing 
If you haven’t used Processing before, open and 
close it once so that it generates the necessary 
files. Download the file here:  
http://bit.ly/TBWPMemoryGame

Unzip the file and move the folder 
“MemoryGame” to the right location. 

Mac 
Documents/Processing 

Step 1 Set up your digital tools 
Before beginning, make sure to download 
Processing as it can take a while. If you haven’t 
set up the Touch Board with Arduino before, 
please do so by following this online tutorial: 
http://bit.ly/TBWPArduino



Windows 
Libraries\Documents\Processing 
My Documents\Processing

Linux (Ubuntu) 
Home/Processing

With the folder in place, open Processing. 
You need to install the “Sound” library for the 
game. In Processing, head to Sketch→Import 
Library→Add Library…

In the search field, look for “Sound” and then 
click “Install”. Once you have installed the 

library, open the game sketch, by heading 
to File→Sketchbook and then opening 
“MemoryGame”. 

Step 6 Connect to the Touch Board 
Once the paint has dried and the code has 
been uploaded to the Touch Board, turn the 
Touch Board off and disconnect it from the 
computer. Select 8 alligator clips and attach 
them to electrodes E0 to E8. Connect the other 
end to the painted buttons making sure that 
paint is in contact with the clips. Make sure that 
none of the cables is crossing over each other, 

as this might cause interference. In the end, you 
want to have a set-up similar to the image on 
the bottom.

Step 7 Play! 
Re-connect the Touch Board to the computer 
and turn it on. In Processing, run the game and 
then press your start button to play. 

Memorise the sequence of colours and press 
the corresponding buttons. Work your brain and 
enjoy the memory game!

Touch Board, microSD Card Reader, 
microSD Card, mini speaker, Micro 
USB cable, alligator clip test leads, 
sticky tabs, velcro stickers 
—
Not included: masking tape, 
foamboard

TAKE IT FURTHER
1 // Use Electric Paint to draw your 
own graphics as interaction points.
2 // Use different code. Follow our 
online tutorials to use MIDI, HID or 
other libraries to produce different 
outputs for your interactive poster.

Interactive 
Poster
Make an interactive poster 
using the Touch Board and 
Printed Sensors. 

Upload sounds or record your 
own audio tracks to tell a story. 
Make your presentations more 
engaging with interactive 
visuals that play sounds!

Then, connect the Touch Board to your 
computer with the USB cable and turn it on. In 
the Arduino IDE, go to

File→Sketchbook→Touch Board 
Examples→Proximity_MP3

Make sure to select the correct Board and Port 
settings before hitting upload.

Step 4 Audio / MP3 files   
We’ve selected some animal facts recorded in 
MP3 format for our sounds. You can use sounds, 
a song, or record your own tracks, use a Text to 
MP3 converter. The choice is yours!

Once your MP3 files are ready, turn the Touch 
Board off, remove the SD card, and insert the 
card with the card reader into your computer. 
On your computer, find the MP3 files that 
you want to use. The names of the tracks 
must be TRACK0XX.mp3, where the XX is 
the corresponding electrode. For example, 
TRACK000.mp3 is played when electrode E0 is 
triggered, TRACK003.mp3 for electrode E3 and 
so on, up to TRACK011.mp3. We’ll be using 
electrode 0, 3, 6 and 11.

Once you have uploaded all the tracks to the 
card, remove the SD card from your computer 
and insert back into your Touch Board.

If you want to have a detailed tutorial on how 
to upload your own MP3 tracks, check out the 
detailed tutorial online:  
http://bit.ly/TBWPChangeMP3

Step 5 Cut the Printed Sensor 
Cut the Printed Sensors into the number of 
sensors you require. Make sure that each piece 
has at least one access node on it. Nodes are the 
exposed circles that are on the perimeter of the 
sensors.

Step 1 Set up your digital tools 
If you haven’t set up the Touch Board with 
Arduino before, please do so by following this 
online tutorial: http://bit.ly/TBWPArduino

Step 2 Plan your poster 
Before you start making the interactive poster, 
you need to plan it out. Think about what your 
interactive points will look like, where they will 
be positioned, and what material your poster will 
be. In this example, we are using 4 printouts of 
animals as our interactive points.  

Step 3 Prepare the Touch Board 
If you have set up the Touch Board for MIDI 
before, make sure to remove all Electric Paint 
from the MIDI bridges. You can chip it off with 
your fingernail. 



Step 6 Attach the Printed Sensors 
Attach each Printed Sensor behind it’s 
designated interaction point (your image). It 
helps to define these first so you can align the 
Printed Sensors directly behind. You can use the 
sticky tabs to attach the Printed Sensors to the 
poster. 

Place the Touch Board at the bottom centre of 
the poster so that you can easily connect to all 
your sensors. You can use the sticky tabs to stick 
them on.

Step 7 Connect the Printed Sensors  
Connect each Printed Sensor piece to the 

Touch Board using alligator clips. It’s easiest if 
you space the clips out on the Touch Board, for 
example, connecting E0, E3, E6 and E11. 

In order to reduce troubleshooting, it’s useful 
to coil up any slack wires and secure them with 
masking tape. Cables that hang around loosely 
tend to cause interference with each other.

Step 8 Test the sensors 
Turn on your speaker and connect it to the Touch 
Board. You can attach it using a velcro sticker. 
Connect the Touch Board to power and turn it 
on. Test one sensor at a time by approaching it 
with your hand. You should hear your tracks!

Step 9 Test your interactive poster 
With everything in place, you can now add the 
final touches to your interactive poster. With the 
Touch Board and the speakers turned on, touch 
your interactive points on the front. You should 
hear your tracks again!

We’d love to see a video of your projects! Share 
your images or videos via Instagram or Twitter  
@Bareconductive.

If you have any trouble, have a look online at our 
Troubleshooting Guide, our FAQs or contact us 
at info@bareconductive.com

How to use  
proximity sensors
Capacitive sensors allow you to either have 
touch sensors, proximity sensors or even 
a combination of both. With the proximity 
sensors, you can choose between having 
an “on or off switch” or using the proximity 
sensing to gradually fade an LED on or off. 

Search: proximity sensors

The Touch Board as  
an HID keyboard
Have you ever wanted to use your Touch 
Board as an HID keyboard input to your 
computer? You might want it to control your 
favourite online arcade game, or maybe 
you have another use in mind that requires 
keypresses. Either way, follow this tutorial 
and soon you will be typing away via the 
power of capacitive touch.

Search: HID

Touch Board 
troubleshooting
If you have just started using the Touch 
Board, you might not be familiar with how 
to debug or troubleshoot any issues you 
might be having. Perhaps the electrodes of 
your board are not responding to touch. In 
this tutorial, we show you how to debug the 
Touch Board.

Search: troubleshooting

How to create 
talking plants
In this tutorial, we’re going to show you how 
to create talking plants. When you approach 
the plant with your hand, you can hear a 
voice message. This can be instructions on 
how to take care of it or just information 
about the plant. For example, we have 
created little instructions that tell the listener 
how much water the plant needs.  

Search: bluetooth

How to clean  
the electrodes
You might have used your Touch Board with 
some Electric Paint, but now you want to 
clean it. This is really simple and safe to do 
and all you need are some baby wipes and 
toothpicks. This tutorial will guide you on 
how to clean your board in 3 simple steps.

Search: clean electrodes

View online versions of the projects above, or find loads more useful 
tutorials and project ideas at bareconductive.com/make Resources

How to fade an LED 
on with proximity and 
the Touch Boardd
 In this tutorial we show you how to fade an 
LED on with proximity and the Touch Board, 
creating a dimmer effect.

Search: proximity



Pi Cap
Give your Raspberry Pi the power of 12 touch 
sensors. Add audio, polyphonic playback, 
GPIO connectors and more!

Electric Paint 10ml
Running low on Electric Paint? Don’t let 
your projects wait. Order more tubes today.

Electric Paint 50ml
Haven’t tried screen printing with Electric Paint 
yet? Get your hands on this jar, asap.

Printed Sensors  
(set of 3)
No time to paint? No problem. Stock up on 
Printed Sensors and get prototyping in no time.

Electric Paint 1L
Scale up your projects. The 1L tub has enough 
material to bring your biggest ideas to life.

Re-stock on Electric Paint and Printed Sensors, or explore other 
great products from our range at bareconductive.com/shopProducts

Light Up Board
Integrate light into your next project with the 
Light Up Board. Pre-programmed with six 
different light modes.




